
Siemens Osakeyhtiö
Automaatiokoulutus

Simatic S7 oppilaitoksille
OP erikoistoiminnatSivu 1

Päiväys 03/2010
Tied.Nr: Oppilaitos_0sa16SIMATIC HMI SITRAIN koulutus

Automaatio ja käytöt
© Siemens Osakeyhtiö 2010. All rights reserved. Oppilaitoksen sisäiseen koulutukseen

WinCC flexible suunnitteluohjelmisto

SISÄLTÖ: Sivu

WinCC flexible suunnitteluohjelmisto
SIMATIC HMI paneelit…………………………………………………………………………………… 2
Käyttäjähallinnan rakenne ja salasanat………………………………………………………………… 3
Käyttäjähallinta ja salasanataulukko operointipaneelissa…………………………………………… 4
Toiminnan salasanasuojauksen konfigurointi – „Security“…………………………………………… 5
Käyränäytön konfigurointi TP170B – „Trend View“…………………………………………………… 6
Reseptit………………………………………………………………………………………………… 7 - 15



Siemens Osakeyhtiö
Automaatiokoulutus

Simatic S7 oppilaitoksille
OP erikoistoiminnatSivu 2

Päiväys 03/2010
Tied.Nr: Oppilaitos_0sa16SIMATIC HMI SITRAIN koulutus

Automaatio ja käytöt
© Siemens Osakeyhtiö 2010. All rights reserved. Oppilaitoksen sisäiseen koulutukseen

SIMATIC HMI paneelit

Multipaneelit

Paneelit

HH170Mobiilipaneelit

Mikropaneelit

70 170 270 370

SIMATIC HMI paneelit Tuoteperheen tekniset tiedot luettelosta ST80
Käyttäjähallinta, trendit, reseptit – käytettävyys riippuu paneelityypistä
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Käyttäjähallinnan rakenne ja salasanat

Käyttäjät:
Runtime users

Ryhmät:
Runtime groups

Ryhmälle sallitut tehtävät:
Runtime

authorizations

User management Käyttäjäoikeuksien hallinta säätelee oikeuksia tietojen ja toimintojen käsittelyyn runtime 
aikana. Sitä varten rakennetaan suunnitteluohjelmalla käyttäjäryhmät ja käyttäjälistat, 
jotka siirretään operointipaneelille. Runtime aikana käyttäjä- ja salasanatietoja 
ylläpidetään käyttäjäkuvassa.

Access protection Toimintojen käsittelysuojaus estää luvattomat prosessin ohjaukset ja suojaa tietoja.
Käyttäjäoikeuksien hallinta on jaettu käyttäjien ja käyttäjäryhmien ylläpitoon. Siten 
toimintaoikeuksien projektointi on erotettu käyttäjien salasanalistojen konfiguroinnista. 
Näin saadaan joustavuutta toimintojen suojaukseen.

Group authorization Toimintaoikeus merkitsee lupaa käsitellä objektia, esimerkiksi oikeutta syöttää
ohjearvoja tai käynnistää moottori painikkeella, sekä suorittaa tiettyjä toimintoja kuten
reseptien editointi.  
Käyttäjäoikeuksien hallinnassa toimintaoikeudet osoitetaan käyttäjäryhmille.
Toimintaoikeus käyttäjätietojen käsittelyyn runtime „User view“-käyttäjänäytössä on 
aina valmiiksi osoitettu pääkäyttäjäryhmälle "Administrators".

User group Kaikilla saman käyttäjäryhmän käyttäjillä on samat toimintaoikeudet.  
Ryhmät "Administrators" ja "Users" on luotu valmiiksi vakioasetuksiin. Vain 
pääkäyttäjillä, “administrators”, on rajoittamaton oikeus kaikkien käyttäjien tietoihin
runtime „User view“-käyttäjänäytössä. 

Users „User” eli käyttäjä on yleissana, joka tarkoittaa henkilöä, joka käsittelee objekteja
WinCC flexible paneelilla tai RT-sovelluksella.
Sisäänkirjautumisella, “logon”, henkilö tunnistetaan tietyksi käyttäjäksi, kun hän
kirjoittaa oman tunnusnimensä ja salasanansa. Käyttäjä kuuluu aina tiettyyn ryhmään ja
saa tämän ryhmän toimintaoikeudet.
Käyttäjä "Admin" on luotu valmiiksi vakioasetuksiin.
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Käyttäjähallinta ja salasanataulukko operointipaneelissa

User view Käyttäjänäytön konfigurointi 
Tehtävänasettelu Jotta käyttäjätietoja voidaan käsitellä runtimessa, on konfiguroitava käyttäjänäyttö “User 

View” kuvaan “Käyttäjät”.
------------------------------------------------------------------------------------------------------

Menettelytapa
User View Avaa kuva ja hae Tools-työkaluikkunan valikosta  käyttäjänäyttö

Tools > Enhanced Objects > User View
ja vie se kuvaan “Käyttäjät”.

Properties Avaa käyttäjänäytön ominaisuusikkuna ja anna seuraavat asettelut:
Avaa luokka

Properties > Layout > Sizing
Aktivoi toiminnat

"Vertical scroll” eli vaakasuuntainen rullaus ja
"Columns movable“, sarakkeiden järjestys muutettavissa. 

Talletus ja testaus
Transfer/ siirto Valitse siirtoasetteluissa salasanalistan ylikirjoitus.

Project > Transfer > Transfer Settings > [v] Overwrite password list

------------------------------------------------------------------------------------------------------
Huomaa Käyttäjänäytön  asetukset tulevat Runtime moodissa voimaan heti. Ne eivät päivity 

suunnitteluohjelmaan (ES).
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Toiminnan salasanasuojauksen konfigurointi – „Security“

Tehtävänasettelu Jotta kuviin konfiguroidut erilaiset toiminnat voidaan suojata asiattomalta käsittelyltä, 
pitää näihin kuvaobjekteihin konfiguroida suojaustasot. toimintaoikeudet. 
Tehdään projektiin seuraavat toimintaoikeuksien määrittelyt eri objekteille:
Objekti Group authorization
Target speed // Nopeusohje Operate/ Ohjaus
Start / Stop // Käynnistys / Pysäytys Operate/ Ohjaus
Message acknowledge keys Ackn.Alarms / 
// Hälytysten kuittauspainike Kuittaa hälytykset
Runtime Stop // Runtime seis Admin / Hallinta
-------------------------------------------------------------------------------------------------

Menettelytapa Oheisessa kuvassa on esimerkkinä toimintasuojauksen määrittely painikkeelle, jolla
päätetään Runtime-käyttö. 

Button Valitse kuvasta painike ja avaa sen ominaisuusikkunasta seurava välilehti
Properties Window > Properties > Security

Runtime
authorization Valitse toimintaoikeustasoksi taso " Administration”, joka sallii kaikkien

systeemiparametrien muuttamisen".  Aktivoi käyttö “Operation/  Enabled”.

Huomaa Oletustasoja toimintaoikeuksien määrittelyssä ovat:
Administration = hallinta
Operate = ohjaus
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Käyränäytön konfigurointi TP170B – „Trend View“

Tehtävänasetus Käyränäytössä halutaan seurata moottorin nopeuden vaihtelua. Konfiguroidaan
käyränäyttö omaan “Käyrät”-kuvaan. Käyränäytössä esitetään nopeuden asetusarvo ja
oloarvo.
------------------------------------------------------------------------------------------------------

Reaaliaikakäyrä Reaaliaikakäyrän avulla voidaan seurata  prosessiarvoja runtimessa. Trendinäyttö tuo 
näkyviin prosessiarvot tietyn aikaikkunan sisällä. 

Menettelytapa Avaa projekti-ikkunasta “Käyrät”-kuva ja lisää siihen Tools- työkaluikkunasta
käyränäyttö

Tools Window > Enhanced Objects > Trend View
General Avaa ominaisuusikkunasta välilehti

Properties Window > Properties > General
ja aseta käyrien määräksi 2 (number of lines). Deaktivoi optio näytä akselien arvot
taulukossa eli "Display value table".

Trend Avaa välilehti Trend ja tee kuvan mukaiset asettelut molemmille muuttujille 
„nopeusohje” ja “nopeusolo”.
Käyrät lisätään taulukkoon klikkaamalla taulukkoriviä (Add curve). Kaksoisklikkaamalla 
Name-sarakkeen solua, voi muuttaa käyrän nimen (Curve_x). 
Käyrän tyypiksi Trend type valitaan „Realtime cyclic triggered“.
Source settings kertoo, mistä haetaan käyrän muuttujan arvo eli tässä suoraan 
prosessimuuttujasta. Muista valita myös värit ja viivan esitys „Display“.  

Axis Avaa välilehti Left Value Axis ja anna akselin loppuarvoksi 1400.
Avaa välilehti Right Value Axis  ja poista oikeanpuoleisen akselin näyttö (off).
Avaa välilehti X Axis ja valitse Mode: Time sekä aikajakso 120 s.
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Reseptien rakenne

Tuotteesta on usein olemassa useita eri versioita: nämä voivat poiketa toisistaan
esimerkiksi seosainemääriltään. Reseptissä kuvataan nämä erot tarkasti.
Resepti koostuu reseptitietueista, joissa talletetaan yksittäisten tuotevaihtoehtojen
erilaiset arvot. Esimerkin arkistokaapilla selvennetään reseptin rakennetta.

Resepti Jokainen resepti vastaa kuvan arkistokaapin yhtä vetolaatikkoa ja siten tarkalleen yhtä
tuotetta. Kun hedelmämehujen sekoituslaitteella pitää tuottaa eri makuvaihtoehtoja
kuten appelsiini-, omena tai greippijuomaa, niin jokaiselle makuvaihtoehdolle
projektoidaan yksi resepti.

Reseptitietueet/
Data records Reseptitietueet vastaavat kukin yhtä vetolaatikon kortistokorttia ja siten tarkkaan yhtä

tuotevaihtoehtoa. Kun hedelmämehujen sekoituslaitteella pitää tuottaa erilaisia
tuotevaihtoehtoja nimikkeinä „Drink“, „Nectar“ ja „Juice“,  laaditaan jokaiselle
nimikkeelle reseptiin omat reseptitietueet.  Tässä tapauksessa eri tuotevaihtoehdot
syntyvät erilaisista sekoitussuhteista.

Reseptin elementit/
Elements Reseptissä määritellään tuotteen parametrit, niin sanotut reseptielementit

(komponenttien sekoitussuhteet). Reseptielementtiin kuuluu näyttönimi (Display name) 
ja muuttuja (Tag). Operointipaneelilla näkyy reseptinäytön taulukossa omalla rivillään
kunkin elementin näyttönimi ja sille syötetty arvo. Arvot voidaan syöttää joko
projektoinnissa tai Runtime-käytössä operointipaneelilla tai koneella. Reseptin arvoja
voi muuttaa operointipaneelilla vain, jos suunnittelija on sen projektoinnissa sallinut.

PLC-ohjelma Tuotteen valmistamiseksi siirretään vastaava reseptitietue operointipaneelilta liitettyyn
ohjaukseen (PLC:lle). Runtime-käytössä ohjauksen muuttujille siirretään tai niiltä
luetaan vastaavat arvot.
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Reseptit

Reseptinäkymä

Resepteillä käsitellään yhteenkuuluvia tietoja kuten koneparametreja tai tuotantotietoja. Nämä
tiedot siirretään työvaiheen mukaisesti operointipaneelilta ohjaukselle, jotta tuotanto voidaan
sovittaa toiselle tuotetyypille. Toisaalta jos parametrointi on tehty suoraan koneella, voidaan
tiedot siirtää operointipaneelille ja tallettaa reseptiin. 

Näyttö Reseptit luodaan omalla reseptieditorilla. Resepti on lista yhteen koottuja muuttujia, jotka on 
talletettu kiinteäksi reseptiksi. Reseptin runko kirjoitetaan WinCC flexiblellä. Reseptin runkoa ei 
voi muuttaa operointitoiminnalla OP/TP/MP-panelilla tai WinCC flex PC_RT RT toiminnassa. 
Jotta reseptejä voidaan näyttää ja käsitellä operointilaitteella, projektoidaan joko reseptinäyttö tai
reseptikuva.

Tietojen syöttö Tietojen syöttöön on seuraavat mahdollisuudet:
Projektointi Jos tuotantotiedot ovat saatavana tai kiinteät, ne voidaan syöttää tai tuoda projektiin jo

projektoinnin aikana reseptieditorissa.
Runtime-käyttö Kun tuotantotietoja pitää muuttaa ja sovittaa usein, voidaan tietoja käsitellä ajon aikana suoraan

operointipaneelilla tai itse koneessa.
Import - tuonti Jos tuotantotiedot on talletettu esimerkiksi serveri-laitteelle tietokantaan, voidaan tuotantotiedot

tuoda operointipaneelille Runtime-käytössä ohjelman import-toiminnalla.
Esimerkiksi elintarviketeollisuudessa tuotanto perustuu tilausmääriin: 
Taulukkolaskentaohjelmasta viedään valmiiksi lasketut arvot CSV-tiedostoon, joka sitten
tuodaan operointipaneelille Runtime-käytössä ja talletetaan reseptitietueiksi.

Reseptin valinta Tuotannossa käytössä oleva reseptin voidaan valita eri tavoin operointipaneelin tyypistä ja 
PLC:stä riippuen: 
- Operointipaneelilta käsin reseptin nimen mukaan (vakio reseptinäkymä tai asiakaskohtainen
reseptikuva) 
- Operointipaneelin toistuvalla tehtävällä
- PLC ohjelman avulla käyttäen PLC job-tehtäviä
- Operointipaneelin ohjelmoidulla tehtävällä (esim. Tag-muuttujan arvon muutos voi liipaista
reseptiarvojen siirron PLC:lle)
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Reseptitietueiden talletus ja siirto

PC-laite/verkko 
ulkoinen muisti

OP-paneelin sisäinen 
muisti tai flash-kortti

PLC:n
muisti

Toiminnot Reseptitietueita voidaan siirtää Runtime-käytössä ulkoisen muistin (kuten Flash-
muistikortti) operointipaneelin ja ohjauksen välillä. Reseptitietueiden siirtoa varten
projektoidaan reseptinäyttö, jossa on tarvittavat toiminnot. Reseptikuvassa käytetään
valmiita systeemitoimintoja.
Voidaan luoda näytöllä uusi reseptitietue, tallettaa se osoitettuun sisäiseen muistiin ja 
siirtää ohjaukselle.
Reseptitietueet voidaan viedä ulkoiseen muistiin, esimerkiksi PC:n kovalevylle. Siellä
ne talletetaan reseptistä riippumatta *.csv muodossa. PC:llä nämä tiedostot voi avata ja 
niitä voi jatkokäsitellä esim. MS Excel-ohjelmalla.
Vastaavasti voidaan operointipaneelin muistista ladata näyttöön ennestään olemassa
oleva reseptitietue tai tuoda arvot ulkoisesta muistista *.csv tiedostona.
Reseptitietue voidaan siirtää myös muistista suoraan ohjaukselle tai ladata PLC:ltä
suoraan muistiin. Samoin voidaan näytössä oleva reseptitietue siirtää ohjaukselle tai
lukea ohjauksesta.

Synkronointi Reseptin konfiguroinnissa on määriteltävä, mikä vaikutus saa olla reseptitietueen tai 
muuttujien (Tags) arvojen muutoksella ohjaukseen.
Siihen on seuraavat kolme vaihtoehtoa:

Ilman WinCC flexible muuttujien (Tags) synkronointia
Synkronointi WinCC flexible muuttujien kanssa
Synkronointi ohjauksen kanssa

----------------------------------------------------------------------------------------------------------
Yläkuvassa merkinnät:
PLC PLC, ohjaus, logiikan muistissa olevat tiedot
Recipe view operointipaneelin näyttö, reseptinäkymä
External data medium ulkoinen muisti, esimerkiksi PC:n kovalevy
Storage medium operointipaneelin projektoinnissa osoitettu sisäinen muisti tai muistikortti 
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Reseptieditori

Editor "Recipes“ Reseptieditorilla luodaan, konfiguroidaan ja käsitellään reseptejä. Lisäksi
reseptieditorilla voidaan kirjoittaa arvot käytettävissä oleviin reseptitietueisiin.

Properties Ominaisuusikkunan esittämät tiedot riippuvat reseptieditorin valinnoista. 
Kun käsitellään välilehtien Elements/ reseptin elementit tai Data records/ reseptitietue
tietoja, voidaan niiden kenttien sisältöä muuttaa vaihtoehtoisesti myös
ominaisuusikkunassa. 

General Valikoissa General ja Properties muutetaan reseptin asetteluja, jotka ovat tärkeitä
projektoinnin aikana. Annetaan reseptin nimi ja nimi operointipaneelin näyttöä varten, 
reseptin numero sekä versiotiedot.

Properties
Data Medium Valikossa Properties > Data Medium määritellään, mihin polkuun talletetaan

reseptitietueen tiedostot.
Options
Transfer Valikoissa Properties/ Options jaTransfer määritellään reseptin käyttäytyminen

Runtime-tilassa. 
Ilman (flex)
synkronointia Syötetyt reseptitietueet esitetään ja niitä voidaan muuttaa vain reseptinäytössä. Jos 

samoja muuttujia käytetään reseptinäytön ulkopuolella, niiden arvot säilyvät 
muuttumattomina.

Synkroinoituna Optiolla „Tags synchronize“ valitaan, että syötetyt tiedot  kirjoitetaan reseptiin 
projektoituihin muuttujiin, joilloin niiden arvot muuttuvat myös muissa kuvissa. 

Offline Optio "Offline" huolehtii, että syötetyt tiedot talletetaan operointipaneelissa muuttujiin, 
mutta niitä ei siirretä syötettäessä suoraan ohjaukselle (PLC:lle). 

No Offline Syötetyt tai luetut tiedot talletetaan muuttujiin ja siirretään  suoraan ohjaukselle 
(PLC:lle).
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Reseptin projektointi, rakenne (1)

Menettelytapa

Reseptin luonti Avatkaa projekti-ikkuna ja kaksoisklikatkaa kansiossa „Recipes“ tunnusta „Add
Recipe“. Valitkaa nimeksi ja näyttönimeksi „Käyttölaji“: 

Properties window > General >Name, Display name

Talletuspaikka Avatkaa ominaisuusikkunassa toimintovalikko
Properties window > Properties > Data Medium

Muistipaikkana käytetään: Storage location / File.
Operointipaneelista riippuen annetaan reseptin talletuspoluksi
- PC_RT sovelluksella kovalevyn kansio, esim.  „Path“: D:\RT\Recipes
- TP170B reseptin talletuspaikka  ”Path”: \Flash\Recipes

Asettelut Avatkaa toimintovalikko
Properties window > Properties > Options
Aktivoikaa optio muuttujien synkronointi „Synchronize Tags“ ja deaktivoikaa optio
„Tags offline".
Avatkaa toimintovalikko

Properties window > Properties > Transfer
Aktivoikaa optio „Synchronize“ ja valitkaa projektin mukaisesti liityntä eli „Connections“
valikossa käytössä oleva S7 –liityntä.
Esimerkissä yläkuvassa projektin „Connections > Name“ on ollut  „DP2“.



Siemens Osakeyhtiö
Automaatiokoulutus

Simatic S7 oppilaitoksille
OP erikoistoiminnatSivu 12

Päiväys 03/2010
Tied.Nr: Oppilaitos_0sa16SIMATIC HMI SITRAIN koulutus

Automaatio ja käytöt
© Siemens Osakeyhtiö 2010. All rights reserved. Oppilaitoksen sisäiseen koulutukseen

Reseptin projektointi, elementit (2)

Reseptin elementit/
Elements Kaksoisklikatkaa välilehden "Elements„ seuraavaa vapaata riviä, jotta ohjelma luo

uuden elementin. Vaihda oletustietojen tilalle kenttien nimet.
Luokaa elementit Kierrosluku, Käynnistysaika, Pysäytysaika ja Pyörimissuunta
samanlaisin näyttönimin. Valitkaa muuttujille seuraava järjestys:

Esimerkkikuvassa Name / Display name Tag
Kierrosluku Ohjaus_nopeusohje
Käynnistysaika Ohjaus_kiihdytysaika
Pysäytysaika Ohjaus_jarrutusaika
Pyörimissuunta Ohjaus_suuntaohje

Reseptitietue
Data records Valitkaa välilehti " Data records ". Kaksoisklikatkaa välilehden seuraavaa vapaata riviä

ja vaihtakaa oletustietojen tilalle kenttien nimet. Kirjoittakaa reseptitietueet „Päiväkäyttö“
ja „Yökäyttö“. 
Parametroikaa elementit haluttujen ajoarvojen mukaisesti.
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Reseptinäkymä - toiminnot

Ohjauskuvakkeet:
Download/Upload 
siirtävät arvot logiikkaan

Kirjoittaa uudet
reseptiarvot
Tallettaa reseptiarvot
Nollata reseptiarvot

Kentät:
Reseptin valinta / 
perusresepti

Reseptitietueen
valinta

Reseptin arvojen
syöttö

Reseptinäkymä on kuvaobjekti, jota käytetään reseptin arvojen esittämiseen ja 
käsittelyyn Runtime-tilassa. Reseptinäkymässä käsitellään yhtä reseptitietuetta
kerrallaan. 

Toimintalaajuus Reseptinäkymän toimintalaajuus on konfiguroitavissa. Yläkuvassa esitetyn täyden
toimintalaajuuden sijasta ovat seuraavat konfiguraatiot käyttökelpoisia: 

Reseptikuvassa voidaan reseptinäkymää käyttää valintakenttänä reseptin tai
reseptitietueen tai molempien valintaan. Sitä varten poistetaan näkymästä kaikki
ohjauskuvakkeet sekä reseptitietueen arvojen taulukko. Silloin prosessikuvassa
esitetään vain kaksi valintakenttää, joilla voidaan valita haluttu resepti ja sen
reseptitietue. 

Jos reseptinäkymällä halutaan esittää reseptitietue vain tarkastusta varten, voidaan
estää arvojen käsittely. Konfiguroinnissa merkitään optio „käsittely sallittu“ ei-
aktiiviseksi.

Runtime - käytös Kun prosessikuvasta, jossa on reseptinäkymä, vaihdetaan toiseen kuvaan, ja jos
reseptinäkymässä ei vielä ole talletettu reseptitietueeseen tehtyjä muutoksia, tulee
ilmoitus, jossa pyydetään tallettamaan reseptitietue. Jotta käyttäjä tietäisi, mitä
reseptitietuetta ei ole talletettu, näytetään samalla reseptin sekä reseptitietueen nimet.
Kun vaihdetaan prosessikuvaan, jossa on ladatun reseptitietueen reseptinäkymä, niin
reseptitietueen arvot päivittyvät automaattisesti.

Käyttö Reseptinäkymää voi käsitellä funktionnäppäimillä, jos esim. operointipaneelilla
Funktionnäppäimillä ei ole kosketustoimintoja. Funktionnäppäimiin voi projektoida reseptikäsittelyn

järjestelmätoimintoja kuten
Softkey_ShiftF4  > Events > Press > System functions > SaveDataRecord .
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Reseptinäkymän projektointi – TP170B sovellus

TP170B Seuraavat ohjeet koskevat TP170B paneelia:
Talletuspaikka Avatkaa ominaisuusikkunassa toimintovalikko 

Properties window > Properties > Data Medium
Muistipaikkana käytetään: Storage location / File.
Reseptin talletuspaikka  ”Path”: \Flash\Recipes

Reseptinäkymä Avatkaa kuva „Resepti“ ja lisätkää objekti reseptinäkymä
Tools > Enhanced Objects > Recipe View

General Avatkaa ominaisuusikkuna ja ottakaa käyttöön seuraavat asettelut valikosta „General“:
Recipe Koska projektissa on vain yksi resepti, sen nimi tuodaan näyttöön. Valitkaa listasta 

reseptin nimi „Käyttölaji“. Reseptinimeä ei käsitellä myöhemmin. Jätetään kenttä „Tag 
for number/name“ vapaaksi. Valintakenttä näytetään [v] jotta reseptin nimi näkyy 
näytössä.

Data record Reseptitietueen nimi pitää näyttää kiinteän ikkunan alueella. Siksi aktiivisen 
reseptitietueen nimi talletetaan muuttujaan „datanimi“. Käyttö Runtime-tilassa sallitaan 
ja taulukoidut arvot näytetään.

View type Näkymän tyypiksi valitaan laajempi näyttö „Advanced view“.

Properties Avatkaa ominaisuusikkunan valikko „Properties“:
Koska näyttö pieni, kannattaa valita reseptinäytön ulkoasuun asettelut: 

Properties > Display > otetaan pois Labels
Text > pienennetään kirjasin > 8 pt

Ohjauspainikkeet Properties > Buttons > valitaan kaikki yleiset komennot.
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Alueosoitteen "Data mailbox" projektointi

Synkronoidussa siirrossa asettavat sekä ohjaus (PLC) että operointipaneeli tilabitit
yhteisellä kommunikointialueella. Siten voidaan ohjausohjelmassa estää tietojen
tahaton ylikirjoittaminen molempiin suuntiin. 

Area pointer Alueosoitteet konfiguroidaan editorissa „Communication“ jokaiselle PLC-yhteydelle
erikseen.  
Connections -> Area pointer -> Data mailbox.

Data mailbox Aktivoikaa välilehti „Area pointer„ alueosoitteet. Projektoikaa alueosoitelistaan
reseptisiirtoa varten alue „Data mailbox“, pituus 5 sanaa. Valitkaa „Aktive“
sarakkeessa „On“. Kirjoittakaa alkuosoitteeksi DB 3 DBW 0 .

PLC ohjelma Siirron valvonta: Kirjoita STEP7 ohjelma FC 21, ja liitä se OB1:een sykliseen 
ohjelmakiertoon. Tässä testissä kuittaus tehdään saman tien, kun data saapunut. 
FC21 Name: REZ-QUIT

A DB3.DBX 7.2 // Siirto valmis virheettä
R DB3.DBX 7.2 // Reseptiarvot/siirto virheettä
R DB3.DBX 7.3 // Resepti DataMailbox vapaa ja siirrossa virhe

Testaus
Käännös ja siirto Talleta ja käännä WinCC flexible projekti. 

Valitse siirtoasetteluissa toiminta „reseptiarvojen ylikirjoitus“.
Project > Transfer > Transfer Settings > [v] Overwrite recipe data records

Käynnistä PC_WCCF_RT  runtime/ TP170B  ja testaa reseptitoimintoja. 



Siemens Osakeyhtiö
Automaatiokoulutus

Simatic S7 oppilaitoksille
OP erikoistoiminnatSivu 16

Päiväys 03/2010
Tied.Nr: Oppilaitos_0sa16SIMATIC HMI SITRAIN koulutus

Automaatio ja käytöt
© Siemens Osakeyhtiö 2010. All rights reserved. Oppilaitoksen sisäiseen koulutukseen

Muistiinpanoja

muistiinpanoja


